
Tutoriel d'introduction à JUICE 7.0
(CC)by-nc-sa *, Florent Beck,

étudiant à l'université de Göttingen

a/ Présentation de JUICE :
JUICE est un logiciel de traitement de données phytosociologiques. Il permet une manipulation très 
facilitée des tableaux à travers un interface adaptée aux besoins de la phytosociologie. La conduite 
de nombreuses analyses et des tests statistiques, finissent d'en faire un outils de travail efficace pour 
le phytosociologue. Ce logiciel ainsi que son manuel1 ne sont disponibles qu'en langue anglaise2. Il 
nécessite un système d'exploitation Microsoft Windows(R).
JUICE est développé par le chercheur tchèque Lubomir Tichý de l'université Masaryk, à Brno.

1 JUICE program for management, analysis and classification of ecological data, Tichy & Holt, 2006

b/ Objectifs du tutoriel :
Cette fiche doit vous permettre d'aborder rapidement et simplement les principales fonctionnalités 
de JUICE. Elle explique deux méthodes simples pour l'import de tables phytosociologiques brutes, 
les principales fonctions de manipulation de la table à la souris et aborde rapidement les principes 
d'analyses statistiques disponibles dans le logiciel.

2 Il n'est pas nécessaire de parler anglais pour suivre ce tutoriel, et donc par conséquent, pour utiliser 
les fonctions de base de JUICE. Cependant il est nécessaire de maîtriser cette langue pour aller plus 
loin et exploiter toutes les fonctionnalités de ce logiciel. NB: Comme je vais traduire ou expliquer 
toutes les inscriptions en anglais nécessaires à l'utilisation de JUICE, certaines parties des textes 
sembleront aux anglophone parfois évidentes, mais cela permettra aux non-anglophone d'aborder 
aussi l'utilisation de ce logiciel merveilleux dont vous reviez depuis si longtemps.

Ceci est un tutoriel SIMPLE, à la porté de n'importe qui (des notions basiques en phytosocio' 
sont tout de même nécessaires). Vous êtes GUIDES PAS A PAS dans chaque étape (et même 

avec des images !). Et tout ce qu'il faut pour comprendre est écrit EN FRANCAIS !

Table des matières pour débutants :

Chapitre I : Acquisition du logiciel et import d'une table phytosociologique brute 
I.1/ Installation 
I.2/ Import d'un tableau brut  
a) à partir d'un fichier texte  
b) à partir d'un fichier Cornell Condensed (TURBOVEG)   

Chapitre II : Premiers pas dans la manipulation phytosociologique sous JUICE    
II.1/ Manipulation de base    
a) les boutons, ils servent à quoi ?  
b) déplacer les espèces et les relevés à la souris   
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Vous trouverez la suite du sommaire en page 11

* Ce document est diffusé sous licence Creative Commons by-nc-sa. Cela signifie que vous êtes libre de 
diffuser ce document, à condition d'en citer l'auteur et à l'exclusion de tout usage commercial.

Vous êtes également libre de modifier ce document puis de le diffuser sous les mêmes conditions.
Visitez : http://creativecommons.org/licenses/by-nc-sa/2.0/fr/ 
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          Chapitre I : Acquisition du logiciel et import d'une table phytosociologique brute :         

I.1/ Installation :
Le logiciel est distribué gruitement par son développeur : M. Tichý.
Vous pouvez le télécharger légalement à l'adresse suivante :
http://www.sci.muni.cz/botany/juice/
Vous obtenez un fichier exécutable Windows (format .exe) qu'il vous suffit de lancer pour procéder 
à l'installation. Pour la configuration minimale nécessaire et l'aide à l'installation, voir le site 
internet et le manuel d'utilisation.

I.2/ Import d'un tableau brut :
JUICE ne supporte pas la numérisation des données phytosociologiques, celles-ci doivent être 
importées depuis un autre logiciel (e. g. bloc-note ou TURBOVEG).
Ce tutoriel n'aborde que deux façons d'importer un tableau de données phytosociologiques et les 
deux formats de fichiers correspondant, pour une plus large information et d'autres méthodes, 
reportez vous au manuel.

a) à partir d'un fichier texte (logiciel bloc-note, format .txt) :
Il faut rédiger (ou coller depuis un tableur) le tableau dans un logiciel de bloc-note (type WordPad, 
BlocNote). La structure à suivre est simple :
> Commencer le tableau dès la première ligne (sans sauter de ligne, ni insérer de titre, ni de 
numéros de relevés).
> Chaque ligne correspond à une espèce.
> Le fichier doit être articulé en 3 colonnes :

1) le nom de l'espèce        2) le numéro de la strate(*) 3) l'indice de recouvrement(**)

> Chaque colonne doit être séparer par des espaces (au moins 5 entre chaque colonne), les colonnes 
n'ont pas besoin d'être placées les unes au dessus des autres. Cela n'est cependant pas déconseillé 
afin d'améliorer la lisibilité du tableau.

Exemple 1 : 

ceci est
correctement
structuré

Exemple 2 :

ceci est
correctement
structuré
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(*) Le numéro de strate doit être renseigné comme suit :
1 = state arborescente haute 2 = strate arborescente moyenne 3 = strate arborescente basse
(si vous n'avez pas de considération haut/moyen/bas, indiquez simplement : 1)
4 = strate arbustive haute 5 = strate arbustive basse
(si vous n'avez pas de considération haut/bas, indiquez simplement : 4)
6 = strate herbacée
7 = juvéniles (plus de 1 an)

8 = semence (moins de 1 an)
9 = strate muscinale

0 = strate non renseignée

(**) La manière d'indiquer l'indice de recouvrement est relativement libre (utilisez tout de même les 
échelles de Braun-Blanquet)
Les indices de recouvrement doivent être indiqués pour chaque relevé, lorsque l'espèce est absente 
du relevé, signalez le en remplaçant l'indice de recouvrement par un point « . », si cette structure 
n'est pas respecté votre tableau sera faussé!
NB : on peut indiquez simplement la présence ou l'absence de l'espèce dans le relevé avec ''1'' et ''.''.

Acer campestre s. campestre     1     +11.11.
Cette ligne signifie donc que l'espèce « Acer campestre s. campestre » [insertion de 5 espaces au 
minimum] située dans la strate arborscente haute (signalée par le premier nombre « 1 ») [insertion 
de 5 espaces au minimum] apparaît dans : le relevé n°1 avec l'indice de recouvrement « + », dans 
les relevés n° 2, 3, 5 et 6 avec l'indice de recouvrement « 1 », et n'apparaît pas dans les relevés 4 et 
7 (signalés par un point : « . »)

Le fichier au format .txt doit être obligatoirement accompagné d'un autre fichier texte (réalisable 
avec le même logiciel) mais au format .tab (écrire simplement .tab à la fin du nom du fichier). Ce 
fichier .tab contient la liste des numéros des relevés. Chaque ligne correspond à un numéro, ils 
doivent être placés dans le même ordre que dans les indices de recouvrement dans le fichier .txt.

Exemple : 

Le nom des deux fichier .txt et .tab doivent être rigoureusement identiques. Ils doivent être placés 
dans le même dossier lors du processus d'import dans JUICE.

Processus d'import : 
Ouvrir le logiciel JUICE, File > Import > Table > From Simple Texte File
Une fenêtre de recherche s'affiche, parcourez votre dossier de travail et selectionnez le fichier au 
format .txt.

La table s'affiche en arrière plan, tandis qu'une fenêtre au premier plan vous invite à prodécer au 
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paramétrage de l'indice de recouvrement. NE SAUTEZ PAS CETTE ETAPE, sinon vous vous 
retrouverez avec un tableau vide !
Cette fenêtre affiche deux colonnes, la première contient des valeurs de pourcentage, la deuxième 
correspond aux symboles que vous avez utilisés pour renseigner vos indices de recouvrement.
Pour ajuster cette échelle, cliquez sur la ligne à modifier et indiquez si besoin, pour chaque 
symbole, le taux de recouvrement associé (exprimé en pourcentage).
Quand vous avez fini cliquez sur « Continue >>> » (et surtout pas sur « Cancel ») !
Votre tableau est prêt, vous pouvez commencer à travailler dessus.

Rendez-vous au chapitre II, page 8, pour commencer à manipuler vos tableaux.

b) à partir d'un fichier Cornell Condensed (logiciel TURBOVEG, format .cc!) :
Le logiciel TURBOVEG permet l'élaboration (numérisation) de bases de données 
phytosociologiques.
Il est développé par le chercheur néerlandais Stephan Hennekens ; il fonctionne sous système 
d'exploitation Microsoft Windows(R) et est disponible en langue anglaise. Une licence utilisateur 
peut être délivrée à titre gracieux pour : les étudiants, un usage privé ou les instituts ou université 
n'ayant pas les moyens financiés nécessaires.
Voir : http://www.synbiosys.alterra.nl/turboveg/ section « Prices » et contactez M. Hennekens 
(stephan.hennekens@wur.nl) [écrire en anglais ou en allemand].

Créez votre base de donnée :
Ouvrez le logiciel TURBOVEG, cliquez sur « Database, New » renseignez le nom de fichier dans 
« Database name » et dans le cadre «Range of releves numbers » indiquez l'interval dans lequel 
doivent être compris les numéros des relevés (en général de 1 à n).

Entrez vos relevés :
Dans la fenêtre « Database : Nom_de_votre_base » cliquez sur « Add a new releve » (2e icône en 
partant de la gauche) :

Dans la fenêtre qui s'affiche alors, renseignez le champ obligatoire : « Cover abundance scale » 
(entrez par exemple ''1'', je ne sais pas à quoi cela correspond mais ça fonctionne et on n'a pas 
besoin de cette fonctionnalité lorsqu'on utilise TURBOVEG dans la seule fin d'exporter la table vers 
JUICE), puis cliquez sur le bouton « Save ».

Une seconde fenêtre s'affiche grâce à laquelle vous allez pouvoir rentrer votre premier relevé.
A droite se trouve la liste des espèces disponibles (dépend de la liste de travail -par pays- que vous 
avez demandée lorsque vous avez fait la demande de licence). Il suffit de taper au clavier les trois 
premières lettres des noms de genre et d'espèce de l'espèce que vous recherchez pour la trouver.
(e.g. : tapez ''fag syl'' pour Fagus sylvatica)
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Dans l'onglet déroulant « Layer » sélectionner la strate correspondante, puis dans la case « Cover » 
indiquez votre indice de recouvrement, enfin cliquez sur le bouton « Add >> »
NB : une même espèce peut être ajoutée plusieur fois dans un relevé en la sélectionnant à nouveau 
et en indiquant des strates différentes.

Une fois que toutes les espèces du relevé ont été entrées, cliquez sur « Save ».

Pour entrer les relevés suivant, recommencez la manipulation (cliquez successivement sur « Oui »et 
sur « Save » dans les deux premières fenêtre qui s'affichent, puis entrez votre relevé et sauvegardez 
en cliquant à nouveau sur « Save ». NB : il ne vous est pas demandé le numéro du relevé, le logiciel 
enregistre les relevés dans l'ordre ordinal. Vous ne pouvez donc pas renseigner le relevé 1 puis le 
relevé 3 puis le relevé 2. Cependant vous pouvez à tout moment revenir sur un relevé renseigné 
précedemment et y effectuer des modifications.

Exportez la base au format Cornell Condensed (.cc!) :

Lorsque vous avez fini d'enregistrer vos relevés, faites un clic droit sur l'un d'entre eux dans la 
fenêtre « Database : Nom_de_votre_base » et choisissez « Select all releves in current 
database » :Ceux-ci seront surlignés en jaune.
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Dans la fenêtre principale, cliquez sur « Export » puis « Cornell condensed species file », dans la 
fenêtre qui s'affiche, choisissez le dossier dans lequel votre fichier .cc! doit être exporté (Target 
directory) et le nom de ce fichier. NE TOUCHEZ A AUCUN AUTRE PARAMETRE, cliquez 
simplement sur le bouton « Export ».

Exportez la liste des abbréviations (!! Indispensable car le fichier .cc! ne transmettra les noms des 
espèces qu'en abbrégé à JUICE. Ce dernier a donc besoin de cette liste pour réattribuer son nom 
correct à chaque espèce.)
Vos deux relevés sont normalement toujours sélectionnés (et donc surlignés en jaune). Dans la 
fenêtre principale cliquez sur « Export » puis sur « Species check list ». Une fenêtre s'ouvre. 
Choisissez le dossier de travail que vous souhaitez (Target directory). Je vous conseille de ne pas 
modifier le nom proposé par défaut (checklst.txt) et de sauvegarder ce fichier dans le dossier où est 
installé JUICE (probablement : C:\Program Files\JUICE).
Dans le cadre « Format output file » sélectionnez « SDF (fixed length) » puis cliquez sur le 
bouton « Export ».

Vous pouvez à présent fermer TURBOVEG (la sauvegarde des informations est automatique).

Import de la table brute dans JUICE :
Ouvrez JUICE, allez dans « File », « Import > Table > From Turboveg or Cornell Condensed 
File », ou utilisez simplement le recourcis clavier « Ctrl+T ».
Une fenêtre de navigation apparaît, sélectionnez le fichier .cc! que vous avez exporté depuis 
TURBOVEG.
Une fenêtre de paramétrage de JUICE s'ouvre : « Import Manager for TURBOVEG or Cornell 
Condensed File (Step 1/5) », cliquez sur le bouton « Next > »
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Vous passez au stade 2 (Step 2/5 - en haut à droite).
NE CHANGEZ RIEN ! Le paramètre « Abbreviations » devrait être par défaut sur ''7+1 (layer)'' et 
le paramètre « Scale » devrait être par défaut sur ''Percentage''. C'est ce qu'on souhaite !
Cliquez sur « Next > ».

Vous passez au stade 3 ; indiquez à JUICE où se trouve la fichier d'export de la liste des 
abbréviations : cochez la case « Use check list » et cliquez sur « Append new check list ».
La fenêtre d'option de JUICE s'ouvre à l'onglet « Check List Import ». Dans le cadre « File 
format » selectionnez « Fixed length » et dans le cadre « Fields » selectionnez « ID Number, 
Abbrev., Spec. Name ». Cliquez sur « Open new check list file » et sélectionnez votre ficher (qui 
doit normalement s'appeller « checklst.txt » et être rangé dans C:\Program Files\JUICE, si vous 
avez suivit mes précédentes recommandations). Cliquez sur le bouton « Test file structure » puis 
sur « OK » et enfin sur « Next > ».

Le stade 4 ne vous intéresse pas (ou alors quand vous serez des pros de JUICE), pour l'instant on se 
contente de cliquer gentiment sur « Next > ».

Votre table a du être correctement importée dans JUICE (c'est le « stade 5 » : « Step 5/5 »).
Vous pouvez commencer à travailler dessus.

NB : dès maintenant, pensez à sauvegarder votre travail ! (File > Save ou Ctrl+S)
Choisissez votre dossier de travail et le nom du fichier, celui-ci portera l'extention JUICE : ''.wct''.
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             Chapitre II : Premiers pas dans la manipulation phytosociologique sous JUICE           

Pour ouvrir un tableau phytosociologique dans JUICE, cliquez sur : « File > Open » ou Ctrl+O.
Voilà à quoi devrait ressembler votre écran à présent : (l'exemple suivant est constitué par un 
tableau brut comportant 70 espèces et 7 relevés).

Zone des « Header Data » : ne fait pas l'objet de ce tutoriel
Zone de « liste des espèces » : ZONE E
Zone de « données » : ZONE D (c'est la bande grisée entre les zones E et A)
Zone d' « affichage » : ZONE A
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II.1/ Manipulation de base :

Il s'agit de déplacer des relevés ou des espèces les un(e)s par rapport aux autres, d'attribuer des 
couleurs à des espèces ou à des relevés, d'aggréger des espèces et des relevés en blocs, insérer des 
séparateurs entre ces blocs, etc.
Jusqu'ici on utilisera que les boutons sous les menus, la souris et le clavier (pas d'anglais!).

a) Les boutons, ils servent à quoi ?
On va les voir un par un, en partant de la gauche :
– « Open » : Ouvrir un fichier de travail JUICE (format .wct).
– « Save » : Sauvegarder le travail en cours dans un fichier au format .wct.

– « aA » : Réduire la taille du texte dans la zone de travail (intéressant quand on manipule de 
grandes bases de données).

– « aA » : Agrandir la taille du texte dans la zone de travail (intéressant pour lire les informations 
qui s'y trouvent).

– « Go back to the table » : permet de sortir de l'affichage des informations obtenues dans le 
menu « Synoptic Table » et de retrouver les informations d'abondance/dominance.

– « Head » (tête de clown) : Affiche et masque les informations contenues dans les Header Data.

– « Find species » (loupe) : Affiche le bandeau de recherche d'une espèce (en bas de l'écran à 
gauche, l'autre gauche, oui, là) il suffit alors de taper les premières lettres du nom de l'espèce et 
d'appuyer sur la touche « Entrée » pour que JUICE fasse défiler la liste des espèces jusqu'à ce 
qu'un nom correspondant à votre recherche s'affiche en haut de cette liste, surlignée en gris 
(NB : cela ne modifie pas l'ordre de rangement des espèces dans la liste : la fenêtre défile 
simplement jusqu'à l'espèce recherchée). Appuyez à nouveau sur la touche « Entrée » pour 
passer à l'espèce suivante contenant les mêmes lettres.

– « Layer » (forêt) : Affiche la strate occupée par chaque espèce dans la zone D (zone en grisée).

Zone de paramétrage des couleurs des espèces
– La case dans laquelle il est écrit « species » indique la couleur principale actuellement utilisée 

pour colorier une espèce.
– Pour colorier une espèce faites un « clic-droit » sur la ligne correspondante (indifférement 

depuis les zones E, D ou A).
– Pour changer la couleur principale avec laquelle vous voulez travailler, cliquez dans la case 

« species » pour passer à la couleur suivante ou cliquez directement sur la couleur de votre 
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choix ou sélectionnez la dans le menu déroulant.
– Vous pouvez regrouper côte à côtes plusieurs espèces coloriées dans la même couleur en 

cliquant sur les flèches « haut » et « bas » dans la zone de paramétrage des couleurs « Gather 
species of the selected colour towards the bottom/the top ». Cela déplace et regroupe toutes 
les espèces ainsi sélectionnées par leur (même) couleur (et qui doit être actuellement la couleur 
principale de travail) jusqu'à l'espèce située le plus en haut ou le plus en bas dans la liste.

– La case « <Ctrl> » correspond à la couleur secondaire de travail.
– Pour colorier une espèce avec la couleur secondaire, faite un clic-droit sur la ligne 

correspondante tout en maintenant la touche « Ctrl » enfoncée. Au lieu d'être coloriée avec la 
couleur principale, l'espèce choisie sera coloriée avec la couleur secondaire.

– Vous pouvez modifier la couleur secondaire avec laquelle vous souhaitez travailler en cliquant 
dans la case « <Ctrl> » ce qui la changera vers la couleur suivante ou en enfonçant la touche 
« Ctrl » de votre clavier et en cliquant simultanément sur la couleur désirée dans la barre des 
couleurs.

– Le bouton « Sort species » est un autre bouton magique que vous allez adoré : il permet de trier 
les espèces (toutes les espèces ou les espèces d'une couleur définie, en fonction de tous les 
relevés ou en fonction des relevés d'une couleur définie).

– Je n'ai malheureusement pas encore compris comment fonctionnent les deux boutons suivant : 
« Merge species » et « Divide species », je vous conseille donc de ne pas les utiliser dans un 
premier temps. Ca fait disparaître des espèces, puis ca créer des lignes dont je ne sais pas à quoi 
elles servent et après je n'arrive plus à réafficher mes espèces disparues. Si vous avez envie de 
bidouiller avec, à vos risques et périls, tenez moi au courant (florent.beck@stud.uni-
goettingen.de) si vous découvrez les mystères de leur fonctionnement et de leur utilité.

– X : Le bouton « Reset selected species colours » permet d'effacer la couleur (colorie en noir) 
les espèces coloriée avec la couleur principale actuelle de travail (clic simple), ou de supprimer 
toutes les informations de colours des espèces (colorie tout en noir) (double clic).

Zone de paramétrage des couleurs des relevés
– fonctionnement analogue à celui de la zone « species ». Pour colorier un relevé, faites un clic-

droit au dessus du numéro de relevé correspondant (danz la zone des Header Data, au dessus des 
indices de recouvrement).

Zone de paramétrage des séparateurs
– Vous pouvez insérer des séparateurs (lignes verticales ou horizontales) entre les relevés et les 

espèces. Pour cela, utilisez le bouton « MAJ » (Shift) de votre clavier et cliquer simultanément 
au-dessus du numéro de relevé, à droite duquel vous souhaitez insérer un séparateur. (Re-
cliquez -toujours en enfonçant la touche « MAJ »- pour effacer ce même séparateur). Procédez 
de même : ''MAJ+clic'' sur la ligne d'une espèce pour insérer un séparateur en dessous.

– Si la case « Separator hierarchy » est cochée, vous avez la possibilité d'insérer différents types 
de séparateurs afin de réaliser une hiérarchie entre vos différents groupes. Pour insérer des 
séparateurs du niveau de hiérarchie souhaité, sélectionné celui ci dans le menu déroulant.

– X : le bouton « reset separators » permet d'effacer tous les séparateurs mis en place.
NB : JUICE traite les relevés/les espèces entre chaque séparateur comme un « groupe ». Le concept 
de « groupe » ainsi définit, est utilisé dans certaines fonctions de JUICE.

b) Déplacer les espèces et les relevés à la souris
Pour déplacer les espèces et les relevés les uns par rapport aux autres à l'aide de la souris. Cliquez 
sur l'espèce ou le relevé choisi, maintenez le bouton de la souris enfoncée, glissez l'espèce ou le 
relevé jusqu'à la place choisie, relachez le bouton ! Ô miracle, ô joie, ô bonheur, plus besoin de faire 
« couper », « insérer », « nouvelle colonne », « coller » comme dans un tableur !
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Partie II
***

à la découverte plus approfondie des entrailles de « la bête »
ou : quand on rentre de manière plus poussée dans les petits menus écrits tout en anglais

(explications en français)
***

Table des matières pour apprentis juicers :

Chapitre I : Acquisition du logiciel et import d'une table phytosociologique brute    
I.1/ Installation   
I.2/ Import d'un tableau brut    
a) à partir d'un fichier texte    
b) à partir d'un fichier Cornell Condensed (TURBOVEG)  

Chapitre II : Premiers pas dans la manipulation phytosociologique sous JUICE  
II.1/ Manipulation de base 
a) les boutons, ils servent à quoi ?   
b) déplacer les espèces et les relevés à la souris   
II.2/ Manipulation des menus 
a) liste des menus et de leur contenu
--- Menus « File » & « Edit »
--- Menu « Species »
--- Menus « Relevés » & « Table » & « Head »
--- Menus « Sorting » & « Separators » & « Synoptic Table »
--- Menus « Indicator Values » & « Analysis » & « Table Simulation » & « Help »

b) Description approfondie des fonctionnalités
--- File > Export
--- File > Options
--- Species > Species Data
     --- Layer Vue & Indicator Value
     --- External Species Data
     --- Cover Value
     --- Frequency
     --- fonctions : Sequence & Species Colour Number & Calculator &  Constant 
Value for [couleur] Species & Make Separators & Species Data Averages & export 
Species Data & Species Group Table
     --- Clear All Species Data
--- Indicator Values > Initiation

2
2
2
4
 
 
9
9
10
12
12
12
13
14
15
16

16
17
19
21
22
23
27
28

29

30
31
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II.2/ Manipulation des menus :
a) liste des menus et de leur contenu :

Les fonctions les plus importantes sont mises en valeur en bleu.

Menu «     File     » :  
– Open : permet d'ouvrir un fichier de travail de JUICE (donc une table phytosociologique)
– Append : menu qui fait buger JUICE
– Save : sauvegarde un fichier de travail de JUICE (format .wct) se comporte systématiquement 

comme une fonction « enregistrer sous » : il ne va donc pas écraser votre dernier fichier sans 
vous demander la permission d'abord.

– Import : Cf. Chap. I, p. 2 du présent tutoriel.
– Export : permet (une fois le travail accompli) de récupérer les beaux tableaux des groupements 

végétaux et de les utiliser dans d'autre logiciels (bloc-note, tableur). Expliqué en détail dans le 
paragraphe II.2.b).

– Conversion : à décourvrir par soit-même, pour utilisateur expérimenté.
– Options : un mal nécessaire, Cf. Chap. II.2.b), p. 19 du présent tutoriel.
– End : vous avez besoin d'un commentaire là ?
– liste des 4 derniers fichiers utilisés par JUICE

Menu «     Edit     » :  
– Undo : permet d'anuler la dernière action
– Find Species : Ctrl+F : même fonction que le bouton loupe. Cf. Chap. II.1, p. 9 du présent 

tutoriel.
– Find Relevé : idem
– Display parameters : ouvre la fenêtre d'options de JUICE sur l'onglet « Display parameters » : 

paramètres d'affichage : taille du texte (boutons +/-), échelle d'abondance/dominance utilisée 
(menu déroulant), largeur de la colonne de la zone D (données concernant l'espèce).

– Copy [couleur] Species Name, Layer and Species Data to Clipboard : copie les informations 
« nom d'espèce », « strate » et « données de l'espèce » pour les espèces de la couleur actuellemet 
utilisée (couleur principale) dans le presse-papier.

– Copy [couleur] Relevé Numer, Short Header ans Group Numbers to Clipboard :  idem 
mais pour les relevés, copie les informations : « numéro de relevés », « header data » et 
« nombre de groupes »

– Past Clipboard to [couleur] Species Name : fonction non testée
– Past Clipboard to [couleur] Short Headers : fonction non testée
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Menu «     Species     » :  
– Undelete Species : anule la suppression d'une espèce.
– Species colour : permet de sauvegarder les attributions de couleurs et de charger ces attributions 

lorsqu'elles ont été sauvegardées.
– Remove Species colour : même fonction que le bouton « X » dans la zone de gestion des 

couleurs.
– Find Species : Ctrl+F : même fonction que le bouton loupe (Cf. Chap. II.1)
– Merge [couleur] Species : Idem que le bouton du même nom (Cf. Chap. II.1)
– Merge all SAME Species Name > Within a LAYER, ou > Within DATASET : permet de 

rassembler en une seule ligne les doublons dans les espèces. Soit en agglomérant les doublons 
présents au sein d'une seule et même strate (> Within a LAYER) soit en agglomérant les 
doublons de toute la liste (> Within DATASET).

– Divide Species into (D) a (r) : fonction non testée
– Add empty species : permet d'ajouter une ligne pour une espèce dont on renseigne le nom et la 

strate qu'elle occupe, mais pour laquelle on ne peut ajouter d'indices d'abondance/dominance.
– Name and Layer Change : permet de modifier le nom et la strate d'une espèce. (possible 

également en double cliquant sur l'espèce souhaitée).
– Highlight (S), (D) and (r) Species : fonction non testée.
– Select Species according to... : permet de chercher une/plusieurs espèce en entrant une partie 

de son nom et de la colorier dans la couleur principale de travail active. Affecte toutes les 
espèces dont le nom comporte la suite de lettre entrées pour la recherche.

– Random Species Selection : permet de sélectionner des espèces au hasard (une ou plusieurs 
d'un seul coup) et de leur affecté une couleur définie.

– Species Data : l'une des fonction les plus importante de ce menu : permet d'afficher des 
informations concernant les espèces dans la zone de données (zone D, colonne grisée) : cela 
permet d'affiner le travail de tri dans les groupes. Les possibilités offertes par cette fonction 
seront détaillées au paragraphe II.2.b).

– Mark Layer : attribue une couleur (à définir) à chaque strate (efface donc toute les couleurs 
précédemment attribuées).

– Combine Layer : permet de rassembler plusieurs strates en une seule (utile par exemple pour 
alléger les strates en cas d'une différenciation trop gênante, comme par exemple : agglomérer les 
strates arborescentes hautes, moyennes et basse en une seule strate arborescente).

– Species Statistics : affiche plusieurs informations statistiques relatives aux espèces, à essayer. 
Pour retrouver la table de travail, retournez dans le menu « Species » et cliquez à nouveau sur 
« Species Statistics ».

– Autorepeat : fonction non testée.
– Delete [couleur] Species : supprime les espèces de la couleur principale active.
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Menu «     Relevés     » :  
– Display Current Relevé : affiche une fenêtre d'information concernant le dernier relevé sur 

lequel on a cliqué. (Le clic peut être effectué au niveau du numéro du relevé, comme dans la 
zone d'affichage (Zone A)).
– nombre d'espèces dans le relevé (supprime les doublons du aux strates)
– fourni l'indice de Shannon-Wiener pour le relevé
– fourni la « eveness »
– indique le degré de recouvrement (comme un code ou comme un pourcentage)
– affiche la liste des espèces présentes dans le relevé en les triant :

– par strate
– par degré de recouvrement
– par ordre alphabétique
– par ?

– permet d'ajouter une espèce au relevé, de supprimer une espèce du relevé et d'éditer les 
Header Data

– Relevé Colours : équivalent de « Species Colours », affecte les relevés.
– Remove Relevé Colours : équivalent de « Remove Species Colours », affecte les relevés.
– Find Relevé : équivalent de « Find Species »
Pour les trois fonctions précédantes, repportez vous aux fonctions équivalentes du menu « Species ».
– Random Relevé Selection : sélection de relevés au hasard
– Mark relevé : fonction non testée.
– [espèce sélectionnée] Relevés List : affiche la liste des relevés dans lesquels la dernière espèce 

sélectionnée (par un clic de souris) est présente, affiche aussi le degré de recouvrement de 
l'espèce dans chaque relevés.

– [couleur] Group Relevés List : affiche la liste des relevés de la couleur de travail des relevés 
active.

– Hunting Dupplicates : permet de vérifier que le jeu de donnée ne contient pas de relevés 
identiques.

– Delete [couleur] Relevés : supprime les relevés de la couleur active.

Menu «     Table     » :  
– List of All Cover and Their Frequency in the Table : affiche une fenêtre dans laquelle se 

trouvent des informations de fréquence pour chaque classe de recouvrement.
– Table Transformation to Presence/Absence Data : modifie l'information 

d'abondance/dominance (degré de recouvrement) par une information de présence/absence : 
attribu à tous les indices de recouvrement la valeur maximale. Utilisation non recommandée : 
mieux vaut utiliser « File > Option > Display Parameters > Presence/Absence Scale » qui 
change l'affichage sans modifier l'information de recouvrement, et permet donc de basculer 
facilement d'un mode en degré de recouvrement à un mode en présence/absence et vice versa.

Menu «     Head     » :  
ne fait pas l'objet de ce tutoriel.
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Menu «     Sorting     » :  
– Move Species : « Upwards/Downwards [couleur] Species » même fonction que les boutons 

flèche haut et flèche bas dans l'onglet de manipulation des couleurs
– Move Relevés : idem que pour les espèces, permet également de déplacer des relevés à 

l'intérieur d'un groupe plutôt que sur tout le jeu de données : a donc un champ d'action plus 
important que les boutons.

– Sort Species : idem que le bouton du même nom (Cf. Chap. II.1.a)
– Sort Relevés : idem que le bouton du même nom.
Pour les 4 fonctions précédentes, mieux vaut utiliser les boutons présentés au paragraphe II.1.a) !
– Sort Short Headers : ne fait pas l'objet de ce tutoriel
– Sort Relevés by Header Data : ne fait pas l'objet de ce tutoriel
– Sort Species Alphabeticaly : permet de trier les espèces par ordre alphabétique, soit les espèces 

sélectionnées avec la couleur active, soit toutes les espèces, ou toutes les espèces à l'intérieur 
d'une strate définie.

– Sort Species by Species Data (Layer, EIV, etc.) : permet de trier les espèces en fonction des 
informations contenues dans la zonnes de données (zone D, en grisé) vues que ces informations 
sont très aisément manipulables et qu'on peut y insérer a peu près toutes les informations que 
l'on souhaite, cela fait de cette fonctionnalité un outil puissant.

– Sort Species in Synoptic Table : réalisable lorsque l'on travaille avec les tables synoptiques 
(Menu « Synoptic Table » dont l'utilisation sera décrite ultérieurement dans ce tutoriel).

– Sort Species by Decreasing Association with Other Species : fonction non testée
– Sort Relevés by Classification by Other Programs : nécessite l'installation de programmes 

complémentaires, avec lesquels JUICE peut travailler en interaction. Ceci ne fait pas l'objet de 
ce tutoriel.

Menu «     Separators     » :  
Apporte peu de fonctionnalités supplémentaires par rapport aux boutons de la barre d'outils. Menu 
simple à exploré en cas de nécessité (utilisateurs avancés de JUICE). Ne fait pas l'objet de ce 
tutoriel. Cf. Chap. II.1.a)

Menu «     Synoptic Table     » :  
– Percentage Frequency : affiche la fréquence relative de chaque espèce, exprimée en 

pourcentage.
– Categorical Frequency : affiche la fréquence de chaque espèce par catégories : V, IV, III, II, I
– Absolute Frequency : affiche la fréquence absolue de chaque espèce (nombre d'occurences).
– Fidelity : concept complexe que ce tutoriel n'a pas pour vocation d'aborder, pour plus 

d'information, voir le manuel. [Traduction de l'anglais : Les mesures de fidelité statistique sont  
utiles pour mesurer la concentration d'espèces dans une unité de végétation et comparer des 
valeurs diagnostiques entre espèces dans une unité de végétation particulière ou entre unités de 
végétation pour une espèce particulière. Issu de « JUICE program for management, analysis 
and classification of ecological data », Tichy & Holt 2006, section 1.10., page 45]

– Cover Values : fonction non testée
– Sort Species in Synoptic Table : idem que la fonction du même nom dans le menu « Sorting »
– Analysis of Columns of Synoptic Table : fonction non testée
– Average Value of Frequency Columns in Synoptic Table : fonction non testée
– No. of Species in Columns of Synoptic Table : fonction non testée
– Threshold Values : (valeurs seuils), ouvre la fenêtre d'options de JUICE à l'onglet « Synoptic 

Table », permet d'y paramétrer un certain nombre de caractères de l'affichage.
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Menu «     Indicator Values     » :  
– Initiation : permet de charger les valeurs indicatrices d'Ellenberg sous JUICE. Cf. Chap. II.2.b)
– Calculation for Relevés : calcule la valeur moyenne des indices d'un relevé.
– Correction for Species Values : fonctionnalité avancée, ne fait pas l'objet de ce tutoriel.

Menu «     Analysis     » :  
Ce menu permet d'accéder à la conduite d'analyses statistiques sur le jeu de données. Il fait appel à 
de bonnes (voir très bonnes) connaissances dans ce domaine. Ce menu constitue l'échelon supérieur 
de l'utilisation de JUICE et en conséquence, ne fait pas l'objet de ce tutoriel. (Et surtout parce que 
je ne maîtrise pas moi-même suffisament pour faire un tutoriel là-dessus, s'il y a des volontaires 
pour rédiger un complément à ce tutoriel pour l'utilisation des analyses statistiques, merci de me 
contacter : florent.beck@stud.uni-goettingen.de).
Pour de plus amples informations, reportez vous au manuel d'utilisation de JUICE.

Menu «     Table Simulation     » :  
Permet d'élaborer une table de données factices. Ne fait pas l'objet de ce tutoriel.

Menu «     Help     » :  
Renvoie à différentes aides en ligne : page principale du programme, manuel d'utilisation, pages 
Internet renseignant sur certains concepts utilisés par JUICE.
Permet vérifier la présence de mises à jour.
Renvoie aux pages web des principaux logiciels que JUICE exploite lors des conduites d'analyses 
statistiques (JUICE ne réalise pas lui même ces analyses, mais exploite les fonctionnalités de 
logiciels qui en sont capable).
Permet d'accéder aux terrifiantes « Extended Hidden Functions » (nécessite un mot de passe). Ce 
niveau du jeu n'est pas accessible aux jeunes padawans, mais seulement aux chevaliers jedi 72e dan 
de JUICE. En bref, seuls les maîtres ont accès à cet univers.
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b) Description approfondie des fonctionnalités

                                                            Menu : « File > Export »                                                         

Dans le cadre de ce tutoriel, je ne présenterai pas toutes les formes d'exportation mais uniquement 
l'exportation, vers un fichier Microsoft Excel(R) (format *.xls), vers un fichier texte simple (format 
*.txt) et vers un fichier texte enrichi (format *.rtf – format similaire au format *.doc).

Export vers le tableur M.Excel  (R)   :  
   Etape  1/2 :  
Dans JUICE, mettez vos données en forme, de manière à ce que le tableau que vous allez exporter 
ait l'aspect voulu.
Allez dans : File > Export > Table > to Spreadsheet Format File
Dans la fenêtre qui s'ouvre vous avez seulement la possibilité :
– de sélectionner les relevés à exportés (tous, ou seulement ceux de la couleur de votre choix) ;
– de définir le nombre de caractères maximum à exporter pour les noms d'espèces (en général, il 

devrait convenir de ne pas modifier ce paramètre, si lors de l'ouverture du fichier exporté, vous 
constatez des rognures dans les noms des espèces, refaites la manipulation en augmentant 
d'autant que nécessaire le nombre de caractères à exporter) ;

– de sélectionner les options suivantes selon vos besoins :
– Export header data : à cocher si vous avez utilisé les données « Head », ce qui ne devrait 

pas être le cas si vous vous êtes tenu à ce tutoriel.
– Export covers in % : à cocher si vous souhaitez afficher les indices de recouvrement en 

pourcentage de recouvrement.
– Use national species name : si vous avez importé les noms français des espèces, cocher 

cette case vous permettra de les exporter. (Mais a priori, je ne vous ai pas appris à le faire 
dans le cadre de ce tutoriel : travaillez un peu vos noms latins, bande de fainéants !)

– Cliquez sur le bouton « Continue >>> »

Une fenêtre d'enregistrement du fichier d'export s'affiche, vous proposant de choisir le dossier de 
destination. Naviguez jusqu'à votre dossier de travail et spécifiez le nom de fichier que vous 
souhaitez utilisé (par défaut il s'agit de Excl_exp.txt).

   Etape 2/2 :
Ouvrir Microsoft Excel(R)  (NB : a priori l'étape 2 ne fonctionne pas directement avec le tableur de la 
suite bureautique d'Open Office). 
Allez dans Fichier > Ouvrir
Naviguez jusqu'au dossier où vous avez enregistré le fichier Excl_exp.txt (ou tout autre nom que 
vous lui avez donné).
Dans « type de fichier », utilisez le menu déroulant pour sélectionner « tous les fichiers (*.*) » ; 
puis recherchez votre fichier Excl_exp.txt et ouvrez le.

La fenêtre de l'assistant d'importation de texte d'Excel(R) va s'ouvrir.
Dans le cadre « type de données d'origine », choisissez « délimité ». En dessous de ce cadre, vous 
avez la possibilité de choisir « Commencer l'importation à la ligne : » avec un numéro de ligne et 
des flèche pour choisir cette ligne. Il est conseillé de commencer l'importation à partir de la 
première ligne d'espèce (qui devrait être la 5e ligne, vérifiez-le dans l'apperçu de votre fichier). 
Choisissez donc « Commencer l'importation à la ligne : 5 » puis cliquez sur « Suivant > ».
Dans le cadre « Séparateurs », décochez « Tabulation » et cochez « Point-virgule » puis cliquez 
sur « Suivant > ».
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Dans l'étape 3/3 de l'assistant, il n'y a, a priori, rien à modifier. Cliquez sur « Terminer ».

Votre tableau se trouve à présent dans Microsoft Excel(R) vous pouvez le mettre en forme comme 
bon vous semble.

 Export vers un fichier texte (format *.txt) :

Dans JUICE, mettez vos données en forme, de manière à ce que le tableau que vous allez exporter 
ait l'aspect voulu.
Allez dans : File > Export > Table > To Simple Text File
Dans la fenêtre qui s'ouvre vous avez seulement la possibilité :
– de sélectionner les relevés à exportés (tous, ou seulement ceux de la couleur de votre choix) ;
– de sélectionner l'option suivante selon vos besoins :

– Use national species name : si vous avez importé les noms français des espèces, cocher 
cette case vous permettra de les exporter. (Mais a priori, je ne vous ai pas appris à le faire 
dans le cadre de ce tutoriel : travaillez un peu vos noms latins, bande de fainéants !)

– Cliquez sur le bouton « Continue >>> »

Une fenêtre d'enregistrement du fichier d'export s'affiche, vous proposant de choisir le dossier de 
destination. Naviguez jusqu'à votre dossier de travail et spécifiez le nom de fichier que vous 
souhaitez utilisé (par défaut il s'agit de table.txt) ; afin de ne pas risquer d'écraser un fichier de 
travail au nom similaire je vous conseille vivement de changer le nom du fichier à exporter !

L'exportation est terminée. Vous pouvez ouvrir votre fichier table.txt avec un logiciel type Bloc-
Note / WordPad.

Export vers un fichier texte enrichi (format *.rtf) :

JUICE privilégie l'export au format de texte enrichi (Rich Format Text : RTF) dont les fichiers 
(*.rtf) s'ouvrent avec des logiciel de traitement de texte (type Microsoft Word(R) ou Oppen Office 
Writter). Pour cela, JUICE créer automatiquement un fichier au format *.rtf. Celui-ci est vide au 
démarrage puis se rempli au fur et à mesure de vos exportations vers ce fichier. Lors de l'export au 
format *.rtf vous n'avez pas la possibilité de choisir le nom du fichier dans lequel vous exportez. Il 
est donc conseillé de renommer le fichier en utilisant la fontion « enregistrer sous » de votre logiciel 
de traitement de texte lorsque vous aurez fini de travailler avec celui-ci. De même, évitez de 
procéder à plusieurs exportations d'affilé vers le fichier RTF, car les tableaux seraient accumulés les 
uns à la suite des autres dans ce fichier.
Ce fichier prédéfini est nommé export.rtf et se trouve par défaut, soit sur le bureau, soit dans le 
dossier où est installé JUICE – généralement C:\Program Files\JUICE.
Vous pouvez modifier cela en allant dans : File > Options, onglet « Export » cliquez sur le bouton 
« Change file » et en spécifiant un nouveau dossier ou fichier.

Dans JUICE, mettez vos données en forme, de manière à ce que le tableau que vous allez exporter 
ait l'aspect voulu.
Allez dans : File > Export > Table > To RTF File
Dans la fenêtre qui s'ouvre vous avez la possibilité : 
– dans le cadre « Species below the table » : de choisir de déplacer les espèces rares en dessous 

de la table, pour ce faire choisissez « In less than 2/3/4 relevés », ce qui affectera le cas 
échéant, les espèces présentes dans moins de 2, ou 4 relevés. Si vous ne souhaitez pas déplacer 
les espèces rares en dessous de la table, chosissez « None ».
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– dans le cadre « Species exported » : choisissez « all » pour exporter toutes les espèces 
(recommandé) ou bien « with non-zero value » pour exporter uniquement les espèces n'ayant 
pas de valeur(s) nulle(s).

– dans le cadre « Export Relevés » : de choisir d'exporter tous les relevés ou seulement ceux de la 
couleur de votre choix.

– de sélectionner les options suivantes selon vos besoins :
– Export Separators : pour exporter les lignes de séparation entre les relevés.
– Use national species name : si vous avez importé les noms français des espèces, cocher 

cette case vous permettra de les exporter. (Mais a priori, je ne vous ai pas appris à le faire 
dans le cadre de ce tutoriel : travaillez un peu vos noms latins, bande de fainéants !)

– Cliquez sur le bouton « Continue >>> »

L'exportation est terminée. Vous trouverez votre tableau dans le fichier « export.rtf », placé par 
défaut sur le bureau ou dans le dossier où est installé JUICE.
N'oubliez pas d'aller ouvrir ce fichier, puis de choisir la fonction « enregistrer sous » afin de 
sauvegarder votre travail.
Après cela, supprimer toutes les données du fichier « export.rtf » afin que la prochaine exportation 
se fasse dans un fichier vièrge et non à la suite du tableau que vous venez d'exporter.

                                                            Menu : « File > Options »                                                        

La fenêtre d'options comporte 8 onglets :
General, Export, External Program Paths, Check List Import, Fidelity Measures, Synoptic 
Tables, Display Parameters et Separators.
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>> Onglet « General » :
– « Dimensions of the program » permet de paramétrer le nombre de relevés et d'espèces à 

afficher dans JUICE. Ce paramètre est d'un usage très restraint dans le cadre de ce tutoriel, car 
les débutants ne seront sûrement pas concernés par des tableaux aux dimensions importantes. 
Les chiffres dans les cases « relevés » et « species » indiquent respectivement le maximum de 
relevés et d'espèces à afficher. Ces valeurs peuvent être élevées jusqu'à respectivement 999 999 
relevés et 99 999 espèces, ce qui implique cependant une utilisation plus importante de la 
mémoire de l'ordinateur.

– « Find species/relevés function » : la première option (à gauche) indique que les caractères 
utilisés pour la recherche d'une espèce ou d'un relevés doivent obligatoirement se trouver au 
début du nom de l'espèce ou du relevé. La deuxième option (à droite) indique que les caractères 
utilisés pour la recherche peuvent se trouver n'importe où dans le nom de l'espèce ou du relevé 
(début, milieux ou fin).

>> Onglet « Export » : permet de paramétrer l'emplacement du fichier au format de texte enrichi 
pour l'export des tables. Cf. section précédante du chapitre II.2.b), p. 18 du présent tutoriel.

>> Onglet « External Program Paths » : comme expliqué précédemment, JUICE ne réalise pas lui 
même les analyses statistiques que vous avez la possibilité de lancer dans le programme. Au 
contraire, il contient une série de scripts qui lui permettent d'uutiliser les fonctionnalités de logiciels 
« amis » comme : Twinspan, D-Map, PC-Ord, Mulva, Syn-Tax 2000, R-Project et Canoco. (Pour 
plus de renseignement sur les fonctions de ces logiciels, voir : Beck, F., (2008) Les bases de 
données phytosociologiques -  Applications à la recherche et à l'enseignement, Université de 
Metz – UFR SCIFA - bah oui quoi, j'ai bien le droit de me faire un peu de pub non ? ;-p

>> Onglet « Check List Import » : permet de définir le chemin d'accès au fichiers des 
abbréviations des noms d'espèces lors de l'import de fichiers au format Cornell Condensed. Cf : 
Chap. I.2.b), p. 6 du présent tutoriel.

>> Onglet « Fidelity Measures » : permet de paramétrer l'affichage de la mesure de fidélité. Cf. 
Chap. II.2.a) > Menu « Synoptic Tables », p.15 du présent tutoriel.
La mesure de fidélité fera l'objet d'une mise-à-jour de ce tutoriel dès que j'en aurais moi-même 
compris les tenant et aboutissant et la manière d'en user dans JUICE.

>> Onglet « Synoptic Tables » : à venir.

>> Onglet « Display Parameters » : CF. Chap. II.2.a) > Menu « Edit », p. 12 du présent tutoriel.

>> Onglet « Separators » : Cf. Chap. II.1.a) > Zone de paramétrage des séparateurs, p. 10 du 
présent tutoriel.
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                                                 Menu : « Species > Species Data »                                                    

Le menu « Species > Species Data » permet de manipuler la colonne de la zone de données (Zone 
D) Cf. p. 8 du présent tutoriel. Celle ci permet d'afficher un grand nombre d'informations 
concernant les espèces présentes dans votre tableau. Comme cette colonne peut faire l'objet de tri, 
cela confère à la compréhension de cette zone et la manipulation de ces données une importance 
toute particulière pour le phytosociologue averti (que vous êtes sûrement, je n'en doute pas :D).

Page 21 / 31



>> « Layer View » : permet d'afficher la strate sous forme de code numérique, Cf. Chap. I.2.a), p.3 
du présent tutoriel, sous forme de texte (en anglais) ou de combiner les deux.

La strate est affichée par défaut sous forme de code numérique dans la zone ''Données''.

Une fois l'affichage sous forme de texte sélectionné, vous aurez sans doute besoin de modifier la 
largeur de la colonne, soit en faisant glisser les repères (encerclés en rouge) à l'aide de la souris, soit 
en passant par « File > Options > Display Parameters > Length of additional species information »

>> « Indicator Value » : permet d'afficher dans la zone de Données une des 6 valeurs indicatrices 
d'Ellenberg : Lumière (Light), Température, Continentalité, Humidité (Moisture), pH (Reaction), 
Nutriments (Nutrients). 
Cf. http://www.tela-botanica.org/projets/18/telechargement/16387 (base de donnée comprenant les 
valeurs d'Ellenberg pour un grand nombre d'espèces végétales).
Nécessite l'initialisation de ces valeurs. Cf. section suivante : Chap.II.2.b).
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>> « External Species Data » : permet d'importer des données depuis un fichier texte.
Cette partie du tutoriel nécessite la maîtrise des logiciels type bloc note et des fichiers au format 
texte (*.txt) OU l'utilisation du logiciel Notepad2.

Le fichier au format texte (*.txt) depuis lequel vous allez importer vos valeurs, doit répondre à une 
structure très précise.
Le nom des espèces pour lesquelles vous voulez importer des valeur doit être rédigé de manière 
exactement identique à celle utilisée dans votre table. (NB : il n'est pas nécessaire que toutes les 
espèces de votre table de travail de JUICE soit présentes dans ce fichier d'importation). Pour éviter 
toute erreur possible, procédez de la manière suivante :
Dans JUICE, allez dans le menu : « Species > Species Data > Export Species Data ». JUICE va 
ouvrir une fenêtre vous demandant de sauvegarder le fichier « nom-de-votre-table_SPDAT.txt ». 
Cliquez sur ''sauvegarder'' puis ouvrez ce fichier. Sa structure correspond exactement à celle qui 
nous est nécessaire à l'importation : deux « colonnes fictives » : une comprenant vos noms d'espèces 
et l'autre comprenant les dernières données avec lesquelles vous avez travaillé (par défaut les 
indications de strate, prenant la valeur « 0 » et/ou « none » si celle-ci n'est pas renseignée).

Dans Notepad2, allez dans le menu « Affichage » et sélectionnez « Afficher les caractères 
invisibles » (Ctrl+MAJ+8).
NB : les espaces apparaissent alors sous la forme de points rouges.

Sur la figure ci-dessus on distingue bien nos deux « colonnes fictives » : les caractères du début de 
la ligne jusqu'au dernier point rouge (espace) avant le chiffre forme la « première colonne », les 
caractères suivant forment la « seconde colonne ». (Sur cet exemple, la « deuxième colonne » est 
sélectionnée et s'affiche surlignée en gris. La « première colonne » correspond à l'ensemble des 
caractères insérés avant le début du champ surligné en gris.

Remplacez les valeurs de la « deuxième colonne » par les données que vous souhaitez importer. 
Vous êtes totalement libre de la quantité de texte à utiliser (pensez tout de même à rester concis afin 
de faciliter la manipulation et la lisibilité une fois les données importées dans JUICE). Vous pouvez 
utiliser des mots, des suites de mots ou des suites de caractères numériques ou alphanumériques de 
votre choix pour coder votre information.
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Chaque espèce ne pourra adopter lors de l'importation qu'une seule valeur, même si vous avez 
deux lignes pour la même espèce (i.e. : parce que vous aviez une espèce présente dans deux strates 
dans votre tableau).
La valeur adoptée sera celle indiquée sur la ligne la plus haut placée pour une espèce en doublon. 
La valeur indiquée sur un doublon situé plus bas dans la liste ne sera pas importée, mais remplacée 
par la valeur de la première occurrence de l'espèce. Vous pouvez soit supprimer la ligne de l'espèce 
soit laisser le champ vide (NB : ceci n'occasionnerait pas une redistribution des valeurs lors de 
l'import, cet import se faisant en respect de la correction du nom et non de la place de la ligne).

Par exemple, dans la figure de la page précédante, l'espèce « Acer pseudoplatanus » apparaît deux 
fois : en ligne 2 et en ligne 3. Deux valeurs différentes ont étés inscrites pour cette espèce : c'est une 
erreur : lors de l'import, seule la valeur apparaissant en premier pour cette espèce sera importée. 
Dans notre cas il s'agira de la valeur « valeur test », la valeur « beispiel » sera ignorée. Lors de 
l'import, la ligne 3 correspondant à l'espèce « Acer pseudoplatanus » se verra attribuer la valeur 
« valeur test ». A la place de « beispiel » il aurait fallu laisser un champ vide ou bien écrire : 
« valeur test ».

Lors de la procédure d'import des données sous JUICE, il vous sera demandé ou commence et ou 
s'arrêtent vos deux colonnes (celle des noms d'espèces et celle des valeurs). Pour se faire, adoptez la 
méthode suivante :
– Surlignez le nom d'une espèce et tous les espaces que vous avez insérez à sa suite jusqu'au 

dernier espace précédant la colonne « valeur » inclus. (Cf. figure ci-après).
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Sur la figure précédante s'affiche en grisé la sélection que vous devez opérer. En bas de la fenêtre du 
logiciel Notepad2, tout à gauche vous trouvez plusieurs informations :
« Lig xx : xx Col xx Sél xx »
« Lig xx » correspond au numéro de la ligne sur laquelle vous vous trouvez, ou, à celui de la 
dernière ligne de votre sélection.
«  : xx » correpond au nombre total de lignes dans votre document.
« Col xx » correspond au numéro de la colonne devant laquelle votre curseur est situé.
« Sél xx » correspond au nombre de caractères que vous avez sélectionné.
C'est ce dernier nombre qui nous intéresse : il correspond au dernier caractère de votre colonne 
« espèces ». Lors de la procedure d'import, vous devrez donc renseigner pour la colonne 
« espèce » : premier caractère = 1er, dernier caractère = 45e.

Sélectionnez ensuite la totalité de la ligne la plus longue de votre fichier, la valeur qui apparaît 
alors dans « Sél xx » correspond au dernier caractère de votre colonne « valeurs ». Dans notre 
exemple la colonne des valeurs commence donc au 46e caractère et s'arrête au 98e.
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Nous allons maintenant pouvoir procéder à l'importation des données dans JUICE. (Et cessez un 
peu de penser « c'est pas trop tôt, ça fait trois pages que tu nous bassine avec tes ânneries », bon !)
Donc, pour rappel, on est en train d'apprendre à se servir du menu « Species > Species Data > 
External Species Data » donc allez cliquez dessus. La fenêtre JUICE suivante s'affiche :

C'est là que vous comprenez toute l'utilité de la démarche effectuée jusqu'à présent : dans le cadre 
« Parameters for species selection » entrez le premier et le dernier caractère de votre colonne 
« espèces », dans le cadre « Species information » entrez le premier et le dernier caractère de votre 
colonne « données » (comme indiqué page précédante).

A présent il vous reste à choisir :
– soit d'utiliser ces valeurs pour effectuer un marquage de couleur dans votre tableau. Pour cela 

cochez la première option : « Mark [couleur] species with the value [valeur] with the colour 
[couleur] » qui signifie : ''marquer les espèces de couleur [couleur] avec la valeur [valeur] en 
[couleur]'' ce qui aurait pour résultat dans notre exemple de marquer en bleu les espèces déjà 
marquées en rouge pour lesquelles la valeur serait vide. Et valider en cliquant sur le bouton 
« Continue >>> ». NB : la fenêtre ne disparaît pas mais si vous cliquez à présent sur le bouton 
« Cancel » vous verez que votre marquage a été effectué.

– soit d'importer vos données pour toutes les espèces (all), ou seulement pour les espèces d'une 
couleur de votre choix. Pour cela cochez la seconde option : « Import data for [couleur] 
species ». Puis cliquez sur le bouton « Continue >>> ».
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>> « Cover Value » : permet d'afficher une valeur d'abondance/dominance (degré de recouvrement)

– Minimum Cover : afficher la plus petite valeur de recouvrement que possède l'espèce au sein 
de tous les relevés

– Average Nonzero Cover : fait la moyenne des valeurs non nulles (donc calcul la moyenne de 
recouvrement de la plante au sein des relevés où elle est présente – exclue les relevés ou la 
plante est absente).

– Median Cover : affiche la valeur de recouvrement médiane
– Maximum Cover : affiche la valeur de recouvrement la plus grande

NB : les degrés de recouvrement affichés dans la zone « Données » sont indiqués en pourcentage et 
non dans le code que vous utilisez (comme par exemple l'échelle « Braun-Blanquet Old Scale 
Normal »). Si vous ne connaissez pas l'équivalence qui existe, vous pouvez l'obtenir simplement en 
allant dans : File > Options > Display Parameters > Current scale et en choisissant dans le menu 
déroulant : « User Defined Scale » puis en cliquant sur le bouton « Modify ».

La fenêtre suivante s'ouvre dans JUICE : 

NB : à la première utilisation cette fenêtre affiche des cases vides – que vous pouvez choisir de 
remplir vous-même si vous travailler avec une échelle de recouvrement personnelle.
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Cochez la case « Braun-Blanquet old scale » - c'est l'échelle la plus répandue - (ou tout autre 
échelle que vous utilisez) puis cliquez sur le bouton « Fill in the predefined scale » les indices de 
l'échelle choisie s'affichent alors en face des pourcentages qui leurs correspondent. Vous pouvez 
utiliser la fonction « Impr écr » (située sur une des touches de votre clavier, en haut à droite de 
celui-ci) puis ouvrir le logiciel « Paint(R) » de Microsoft Windows(R) ou tout autre logiciel de dessin 
et utiliser la fonction ''Edition > coller'' (Ctrl+V) pour obtenir une image de votre échelle de 
correspondance que vous pouvez alors sauvegarder et conserver durablement afin de l'utiliser à côté 
de JUICE. Ou bien vous servir tout simplement de celle qui figure ci-dessus.

>> « Frequency » : Permet d'afficher dans la zone des données la fréquence absolue de l'espèce.

Soit dans toute la table (All Table), soit dans les relevés de la couleur active ([couleur] Relevés), 
soit la fréquence au sein des relevés pour lesquels la valeur de recouvrement est plus grande qu'une 
limite (threshold) définie (à définir dans le menu « File > Options », onglet « Synoptic Tables », 
valeurs « Cover threshold: » basse (lower) et haute (higher).
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>> « Sequence » : attribue un numéro à chaque espèce de votre liste, de 1 à n dans l'ordre dans 
lequel se trouve votre liste au moment où vous utilisez cette fonction. Le principal usage de cette 
fonction est sans doute de pouvoir retrouver facilement un agencement spécifique. Une manière de 
« sauvegarder » l'information de la place des espèces les unes par rapport aux autres, avant 
d'apporter des modifications à cet agencement.

>> « Species Color Number » : attribue à chaque espèce le numéro de sa couleur (0 pour noir, 1 
pour rouge, 2 pour bleu, etc en suivant l'ordre des couleurs de la barre de tâches).

>> « Calculator » : permet de réaliser des opérations mathématiques simples sur une valeur 
numérique enregistrée dans la colonne « Données ».

>> « Constant Value for [couleur] Species » : permet d'attribuée une valeur constante aux espèces 
de la couleur active.

>> « Make Separators » : chaque fois que la valeur de la donnée d'une espèce n'est pas identique à 
celle de sa voisine du dessous, JUICE insère un séparateur entre ces deux espèces.

>> « Species Data Averages » : lorsque les valeurs dans la colonne des données sont sous forme 
numérique, ouvre une fenêtre qui donne la moyenne (average) ou la valeur minimale ou maximale.

>> « Export Species Data » : permet d'exporter la liste des espèces avec leurs valeurs 
correspondantes dans un fichier texte (*.txt).

>> « Species Group Table - ... » : permet d'afficher des tableaux récapitulatifs sur la répartition de 
groupes de végétaux au sein des relevés. Pour illustrer les quatres fonctions suivantes, on 
considérera les « groupes » suivant :
– groupe « Acer campestre s. campestre » comprenant 3 espèces : Acer campestre en strate 

arborescente, Acer pseudoplatanus en strate arbustive et Acer pseudoplatanus en strate 
arborescente.

– Groupe « Aconitum napellus s. vulgare » comprenant 3 espèces : Aconitum napellus, Adoxa 
moschatellina et Allium ursinum toutes trois en strate herbacée.

– Groupe « Anemone nemerosa » comprenant 3 espèces : Anemone nemerosa, Anemone 
ranunculoides et Arum maculatum, toutes trois en strate herbacée.

Cf. Tableau de base ci-dessous :

La réalité de ces groupes ne nous intéresse pas, il s'agit de montrer le fonctionnement des 
fonctionnalités. La réalité des résultats n'est pas l'objet. 
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     --- « Species Group Table - FREQUENCY (%) » : affiche (en vertical) pour chaque relevé, la 
fréquence d'apparition d'espèces au sein de ce relevé (en pourcentage) :

Dans le groupe un, sur les trois espèces qui composent le groupe, seules deux apparaissent dans le 
relevé 1 : 2/3 = 67%. Une seule espèce apparaît dans le relevé 2 : 1/3 = 33%. Les trois espèces sont 
présentes dans le relevé 3 : 3/3 = 100%. etc.
NB : JUICE affiche également le nombre d'espèces présentes dans chaque groupe (Total: 3).

     --- « Species Group Table - FREQUENCY (cat. I-V) » : affiche le même résultat sous forme 
de catégories de I à V.

     --- « Species Group Table - COVER » : à venir.

     --- « Species Group Table – SPECIES No. » : affiche le nombre d'espèce du groupe présentes 
dans chaque relevés.

>> « Clear All Species Data » : efface les valeurs de la colonne « Données ». Celle-ci apparaît 
alors vide.
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Menu : « Indicator Values > Initiation »

Le menu « Indicator Values », permet d'utiliser dans JUICE les valeurs indicatrices des végétaux, 
telles que décrite par M. Ellenberg.
Ces valeurs sont au nombre de six :
– L : lumière (Lichtzahl),
– T : température (Temperaturezahl),
– K : continentalité (Kontinentalitätzahl),
– F : humidité (Feuchtezahl),
– R : pH (Reaktionzahl),
– N : nutriments (Nährstoffzahl).
La salinité n'est pas paramétrable sous JUICE en tant que valeur indicatrice. Cependant, vous 
pouvez très facilement l'importer en tant que valeurs attribuées aux espèces dans la zone de 
données. Cf. Section précédante « External Species Data », p. 23 et suivantes du présent tutoriel.

Pour utiliser les valeurs d'Ellenberg, celles-ci doivent être initialisées. Pour cela, allez dans le menu 
« Indicator Values > Initiation » une fenêtre JUICE va s'ouvrir. Cliquez sur le bouton « Initiation 
of indicator values ». JUICE va vous demander où se trouve le fichier texte dans lequel sont 
enregistrées les valeurs d'Ellenberg. Indiquez lui le chemin vers celui-ci et laissez le logiciel charger 
les valeurs.

Vous pouvez obtenir un fichier tout prêt contenant les valeurs indicatrices d'Ellenberg à l'adresse 
suivante :
Ellenberg indicator values : ELLENB.txt 
http://www.wuala.com/Floppyboy/phytosocio/ELLENB.TXT
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